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Copyright Notices
© 2013, Wyse Technology LLC. All rights reserved.

This manual and the software and firmware described in it are copyrighted. You may not reproduce, transmit, 
transcribe, store in a retrieval system, or translate into any language or computer language, in any form or by any 
means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, any part of this publication 
without express written permission.

End User License Agreement (“License”)
A copy of the Wyse Technology End User License Agreement is included in the software and provided for your 
reference only. The License at http://www.wyse.com/license as of the purchase date is the controlling licensing 
agreement. By copying, using, or installing the software or the product, you agree to be bound by those terms.

Trademarks
The Wyse and PocketCloud logos and Wyse and PocketCloud are trademarks of Wyse Technology LLC. Other 
product names mentioned herein are for identification purposes only and may be trademarks and/or registered 
trademarks of their respective companies. Specifications subject to change without notice.

Patents
This product and/or associated software are protected by copyright, international treaties, and various patents, 
including the following U.S. patents: 6,836,885 and 5,918,039.

Restricted Rights Legend
You acknowledge that the Software is of U.S. origin. You agree to comply with all applicable international and 
national laws that apply to the Software, including the U.S. Export Administration Regulations, as well as end-user, 
end-use and country destination restrictions issued by U.S. and other governments. For additional information on 
exporting the Software, see http://www.microsoft.com/exporting.

Ordering Information
For availability, pricing, and ordering information in the United States and Canada, call 1-800-GET-WYSE 
(1-800-438-9973) or visit us at wyse.com. In all other countries, contact your sales representative.

FCC Statement
This equipment has been tested and found to comply with the limits for either Class A or Class B digital devices, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Shielded interconnect cables and shielded AC power cable must be employed with this equipment to insure 
compliance with the pertinent RF emission limits governing this device. Changes or modifications not expressly 
approved by the system’s manufacturer could void the user’s authority to operate the equipment.

CAUTION: Modifications made to the product, unless expressly approved by Wyse Technology, could void the 
user’s authority to operate the equipment.
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Regulatory Compliance for Thin Clients

Basic EMC and Safety Requirements
Wyse appliances are compliant with the regulatory requirements in the regions listed below.

U.S.A.—FCC Part 15 (class B), cUL 60950

Canada—IC ICES-003, CAN/CSA-C22 No. 60950

Europe—EN 55022 (class B); EN 55024

Canadian DOC Notices
Class A - This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications. 
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux 
appareils numériques de la classe A prescrites dans le Réglement sur le brouillage radioélectrique édicté par le 
Ministère des Communications du Canada.

Class B - This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications. 
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux 
appareils numériques de la classe B prescrites dans le Réglement sur le brouillage radioélectrique édicté par le 
Ministère des Communications du Canada.

Wireless Usage and Requirements
Radio transmitting type devices (RF module) are present in models with the wireless option. These devices 
operate in the 2.4 GHz band (i.e. 802.11B/G/N LAN & Bluetooth). 

As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a 
wireless device near the body (this does not include extremities) is typical. This device should be used more than 
20 cm (8 inches) from the body when wireless devices are on and transmitting.

Some circumstances require restrictions on wireless devices. Examples of common restrictions include:
• When in environments where you are uncertain of the sanction to use wireless devices, ask the applicable 

authority for authorization prior to use or turning on the wireless device.
• Every country has different restrictions on the use of wireless devices. Since your system is equipped with a 

wireless device, when traveling between countries with your system, check with the local Radio Approval 
authorities prior to any move or trip for any restrictions on the use of a wireless device in the destination 
country.

• Wireless devices are not user-serviceable. Do not modify them in any way. Modification to a wireless device 
will void the authorization to use it. Please contact the manufacturer for service.

Device Power Supply
Use only the external power supply that comes with your thin client. For power and voltage ratings, see the serial 
number label or regulatory label on your device. For power adapter replacement, contact your Wyse Service 
Representative. For proper replacement compare the labels on both mobile thin client and power adapter to 
ensure that their voltages match. 

WARNING: Use of any other power adapter may damage your mobile thin client or the power adapter. The 
damage caused by an improper power adapter is not covered by warranty.

Battery Information
Model Tx0 contains an internal button cell battery replaceable by Wyse or one of our Authorized Service Centers. 
For service, visit http://www.wyse.com/support/authorized-service-centers.

WARNING: There is a risk of explosion if the battery is replaced by an incorrect type. Always dispose of used 
batteries according to the instructions accompanying the battery. 
 
Perchlorate Materials - Special Handling May Be Required under California Code of Regulations, title 22. (Only 
required within the U.S.A.)
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1 Introduction

Wyse® Enhanced Ubuntu™ Linux combines the security, flexibility, and market-leading 
usability of Ubuntu™ (trademark of Canonical Group Limited) with Wyse’s cloud 
computing optimizations in management and user experience. It is ideal for organizations 
that want to run server-based, Web-based, or local applications (including legacy 
applications) without the deployment and security concerns of a non-standard Linux 
distribution.

About this Guide
This guide is intended for administrators of Wyse thin clients running Wyse Enhanced 
Ubuntu Linux. It provides information and detailed system configurations to help you 
design and manage a Wyse Enhanced Ubuntu Linux environment. Depending on your 
hardware and software configurations, the figures you see may be different than the 
example figures shown in this guide. 

This guide supplements the standard Ubuntu documentation supplied by Canonical Inc. 
and explains the differences, enhancements, and additional features provided by Wyse 
with the thin client. It does not attempt to describe the standard features found in Ubuntu.

Ubuntu help can be accessed from the Ubuntu Support Web site at: 
http://www.ubuntu.com/support.

Finding the Information You Need in this Guide
You can use either the Search window or Find toolbar to locate a word, series of words, or 
partial word in an active PDF document. For detailed information on using these features, 
refer to the Help in your PDF reader.

Wyse Technical Support
To access Wyse technical resources, visit http://www.wyse.com/support. If you still have 
questions, you can submit your questions using the Wyse Self-Service Center at 
http://support.wyse.com/selfservice.html or call Customer Support at 1-800-800-WYSE 
(toll free in U.S. and Canada). Hours of operation are from 6:00 A.M. to 5:00 P.M. Pacific 
Time, Monday through Friday.

To access international support, visit http://www.wyse.com/global.

Related Documentation and Services
Fact Sheets containing the features of hardware products are available on the Wyse Web 
site. Go to http://www.wyse.com/products and use the Cloud clients tab to locate and 
download the Fact Sheet for your hardware product.
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2 Chapter 1
Reference Guide: Wyse ® Enhanced Ubuntu™ Linux INI Files is intended for 
administrators of Wyse thin clients running Wyse Enhanced Ubuntu Linux. It provides the 
detailed information you need to help you understand and use the Wyse Enhanced 
Ubuntu Linux INI files. It contains information on the different INI files you can use and the 
rules for constructing the files. It also provides the parameter details you need (with 
working examples) to get the most out of your INI files. It is available at: 
http://www.wyse.com/manuals.

Wyse Cloud Software is available on the Wyse Web site at: 
http://www.wyse.com/products/software.

Enhancing Your Experience with Wyse Software
Wyse provides several software products that are specifically designed to enhance your 
thin client experience. Wyse Thin Computing Software is available on the Wyse Web site 
at: http://www.wyse.com/products/software.

Wyse Online Community
Wyse maintains an online community where users of our products can seek and exchange 
information on user forums. Visit the Wyse Online Community forums at: 
http://community.wyse.com/forum. 
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2 Getting Started: Quickly Learning 
the Basics
Use the following information to quickly learn the basics and get started using your thin 
client:
• "Logging In"
• "Using Your Home Screen"
• "Configuring Thin Client Settings and Connections"
• "Connecting to Network and Session Services"
• "Connecting to a Printer"
• "Connecting to a Monitor"
• "Locking, Logging Out, Shutting Down, Restarting, and Suspending"
• "Additional Getting Started Details"

TIP: While it can be used in environments without central configuration for basic 
connectivity needs, Wyse Enhanced Ubuntu Linux is designed to be centrally managed 
and configured using INI files. In general, it is recommended that you use central 
configuration to enable you to automatically push any desired default configuration to all 
supported thin clients in your environment (see "Central Configuration: Automating 
Configurations"). 

Logging In 
TIP: On your initial connection to central configuration it is recommended that you connect 
using a “wired connection” (plug in the network-connected ethernet cable to your thin 
client before starting the thin client) to obtain the configurations desired by the 
administrator (connections, system settings, required certificates and so on). This “wired 
connection” will also provide any wireless configurations provided by the administrator 
through the INI files.  
If you must initially connect to central configuration through wireless, use the Edit 
Wireless Connection dialog box (click System Settings > Network Connections > 
Wireless tab > Add) to create a wireless connection where you can enter the SSID and 
encryption configurations required/set up by the network administrator (see "Network 
Connections").

After your thin client starts, Administrators (high privilege) can log in to your Home screen 
using the default user name admin and the default case-sensitive password admin. It is 
highly recommended that you change the default password by using the User 
Administration dialog box in System Settings (see "User Administration"). 
Note that Thinuser users (low privilege for locked mode end-user) can use the default user 
name thinuser and the default case-sensitive password thinuser; Guest users (no 
privileges Kiosk type setup) can use default user name guest and do not need a 
password.
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4 Chapter 2
Using Your Home Screen 
The Wyse Enhanced Ubuntu Linux Home screen is designed for efficiency and usability. 

Use the following guidelines (depending on user privilege, some options may not be 
available for use):

TIP: Each icon has a pop-up description for easy identification. 

Table 1 Menu bar icons 

Icon What It Does

Home Displays your Home screen (useful when many windows are 
open and you want to quickly access your Home screen). 

Open Applications 
and Connections

Currently open application and connection icons are 
displayed in the menu bar for convenient access. 

Network Manager Manages your wired and wireless network connections (see 
"Connecting to Network and Session Services").

Volume Controls the audio volume (use the slider, click Mute All or 
Unmute as needed; Note that for these settings to take 
effect, sound must be supported and enabled on the server 
used for ICA or RDP connections).

Calendar Lists the time, day of the week, and date. You can click the 
calendar to display the calendar window.

System Settings Sets up your thin client hardware, look and feel, and system 
settings (see "Configuring System Settings").
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Getting Started: Quickly Learning the Basics 5
The Home screen also contains:
• Right-click menu - Right-clicking the menu bar provides options to customize your 

menu bar and panel. For example, the Customize Panel option allows you to move 
your menu bar to the top, left, bottom, or right of your Home screen.

• Home Screen Application and Connection icons - Each application and connection 
icon opens the connections made available by an administrator. For example, a 
browser, the terminal emulator window (see "Using Wyse Terminal"), or other available 
connections (see "Configuring Connections").

• Enter Edit Mode button - Enters the Home screen edit mode allowing you to 
(depending on user privilege level, some edit mode features may not be available for 
use; to exit edit mode, click the Exit Edit Mode icon):
· Edit connections - Click an icon and configure (see "Configuring Connections")
· Delete connections - Click the delete button of an icon and confirm.
· Add new connections - Click the Add Item icon, click the connection you want to 

add, and then configure (see "Configuring Connections").

System Information Opens the System Information dialog box. Use this dialog 
box to view system information about the thin client (see 
"Viewing System Information").

Quit Opens the Shutdown dialog box. Use this dialog box to lock, 
logout, shutdown, restart, or suspend your thin client (see 
"Locking, Logging Out, Shutting Down, Restarting, and 
Suspending").

Table 1 Menu bar icons, Continued

Icon What It Does
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6 Chapter 2
Home Screen Keyboard Shortcuts
Depending on the type of application window you are using (full screen, standard, or 
seamless), you can use shortcut keys (see Table 2) to manage windows. Note that you 
can also define shortcuts for launching applications (see "Keyboard").

TIP: The shortcut keys Alt+DownArrow (allows you to switch windows using a dialog box) 
and Alt+Ctrl+DownArrow (minimizes or maximizes all windows) are useful for navigating 
multiple remote sessions without having to log out. 

CAUTION: If inside a session, some connection types will grab all the keystrokes and the 
shortcuts may not always work. Be sure to check product release notes for the latest 
details.

Configuring Thin Client Settings and Connections
While the use of Wyse INI files is recommended to configure thin client settings and 
connections available to users (see "Central Configuration: Automating Configurations"), 
you can use dialog boxes on a thin client to:
• Set up your thin client hardware, look and feel, and system settings (see "Configuring 

System Settings").
• Configure and add connections to your Home screen for use (see "Configuring 

Connections").

Table 2 Window-related Shortcut Keys 

Window Action Press

Maximize window Alt+F10

Switch windows using a dialog box. Alt+DownArrow

Minimize/maximize all windows Alt+Ctrl+DownArrow

Move window with arrow keys Alt+F7 and press an arrow key

Resize window Alt+F8 and press an arrow key

Close the window Alt+F4
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Getting Started: Quickly Learning the Basics 7
Connecting to Network and Session Services
Use the Network Manager icon, located on the right side of the Menu bar, to display 
information about the status of your network connection and to connect or disconnect. 

Use the following guidelines:
• Click the Network Manager icon to display the Wired Network and Wireless Network 

menus. For example you can click the Network Manager icon, and then select an 
available wired or wireless network to use.

• Right-click the Network Manager icon to display the Enable Networking, Enable 
Wireless, Enable Notifications, Connection Information, and About options. For 
example, you can right-click the Network Manager icon, and then click Enable 
Wireless to remove the check and disable wireless.

• Hover your mouse pointer over the icon to view a message displaying the status (No 
Network Connection, Wired Network Connection Active, and Wireless Network 
Connection Active) and name of the network to which your thin client is connected. For 
example, connecting your thin client to a wired network (by attaching the network cable 
to your thin client) displays the Wired Network Connection Active status.

For wireless connections (802.11b/g/n Wireless LAN), you can click the Wireless Network 
Connection icon (or click the Network Manager icon) in the menu bar to see if a wireless 
network connection is available. You can click an available wireless network connection to 
open and use the Wireless Network Authentication dialog box. After authentication, the 
wireless network is available for use.

TIP: For information on importing certificates that your network may require (according to 
your administrator), see "Import Certificates."

Connecting to a Printer
To connect a printer to your thin client through a USB port, you will need a USB-to-printer 
adapter cable (not included). Before use, you may need to install the driver for the printer 
by following the printer driver installation instructions. For information on connecting to 
printers, refer to "Printers." 

Connecting to a Monitor
Monitor connections can be made using the DVI (digital) monitor port and the proper Wyse 
monitor cables/splitters. For VGA (analog) monitor connections, you must use the 
included DVI-to-VGA adapter. For information on configuring display settings, see 
"Display."

TIP: Dual Monitors - When using a DVI to DVI/VGA splitter with VGA and DVI monitors at 
the same time, note that the VGA monitor will be the primary monitor.
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8 Chapter 2
Locking, Logging Out, Shutting Down, Restarting, and Suspending
After using your thin client, you can click the Quit icon and select one of the following 
(depending on user privilege, some options may not be available for use; note also that 
the shutdown screen is not configurable using INI parameters):
• Lock - Locks your thin client (display is blank after you click the icon). To unlock your 

thin client, move the mouse, enter your credentials, and then click Unlock.
• Logout - Logs you out of your session (however, the thin client continues to run).
• Shutdown - Shuts down and turns off your thin client.
• Restart - Shuts down and restarts your thin client.
• Suspend - Places the thin client in Standby mode to preserve power. To exit Standby 

mode, click the mouse, or press the space bar on the keyboard, or press the return key 
on the keyboard.

Additional Getting Started Details
This section includes additional details on the following:
• "Viewing System Information"
• "Using Wyse Terminal"
• "Restoring Default Settings with WLoader Setup"

Viewing System Information
Use the System Information dialog box (click the System Information icon in the Menu 
Bar) to view Identity, Network, Package, System Log, and Copyright information:
• Identity tab - Displays identity information such as Current User, Terminal Name, 

Product Name, Platform, Build, Ubuntu, OS Version, Uptime, Processor, Processor 
Speed, Total Memory, Free Memory, Flash Size, Serial Number, and BIOS Version.

• Network tab - Displays network information for ethernet (eth0) and wireless LAN 
(wlan0) such as MAC Address, Network Speed, MTU, IP Address, IPv6 Address, 
Subnet Mask, Gateway, Domain, Primary DNS, Secondary DNS, DHCP Server, 
Lease, and Elapsed time.

• Packages tab - Displays the Package information, including packages names, 
versions, and sizes that are installed on the thin client.

• System Log tab - Displays the System Log information, including various messages 
generated during the operation of the thin client.

• Copyright tab - Displays the software copyright and patent notices.
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Getting Started: Quickly Learning the Basics 9
Using Wyse Terminal 
Clicking the Terminal icon on the Home screen opens the Wyse Terminal emulator 
window. Wyse Terminal allows you access to a text terminal and all its applications such 
as command line interfaces (CLI) and text user interface applications. You can click the 
Window menu (upper left window icon in the terminal window) to open and use available 
menu options. You can type help and press Enter to display a verbose message 
describing available options. NOTE: Terminal is for various low level administrative 
purposes. It is available only to users with high privileges. It is recommended for 
experienced administrators who have extensive knowledge of the Linux system.

Restoring Default Settings with WLoader Setup
Depending on the default settings you want to restore on the thin client, you can use the:
• WLoader Setup to restore various default values (see "Accessing Thin Client Boot 

Order Settings")
• Recovery option to restore the complete image including removing any updated 

packages (see "Restoring the Complete Image")

Accessing Thin Client Boot Order Settings
1. Power off the device.

2. Press and hold the Delete key while pressing and holding the Power button to power 
on the device.

3. When the Activity light (next to the Power button) blinks, release the Power button.

4. When the BIOS password prompt is displayed, release the Delete key.

5. Type Fireport as the password to enter and use the WLoader Setup. For example, you 
can use the Boot Order to select the boot option you want.

Restoring the Complete Image
1. Power off the device.

2. Press and hold the P key while pressing and holding the Power button to power on the 
device.

3. When the Activity light (next to the Power button) blinks, release the Power button.

4. When the BIOS password prompt is displayed, type Fireport as the password.

5. When the one-time boot menu of options is displayed, select the Recovery option and 
then press Enter (restores the complete image and removes any updated package).
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3 Configuring System Settings 

Clicking the System Settings icon in the Menu bar displays the following System Settings 
options that you can configure locally on a thin client using dialog boxes (depending on 
user privilege level, some dialog boxes and options may not be available for use):

TIP: While it is not recommended to use dialog boxes for configuring thin client system 
settings, they are available in case you want to temporarily override central default 
configurations or you do not have the option to set up central configuration (smaller 
environments). In general, it is recommended that you use central configuration to enable 
you to automatically push any desired default configuration to all supported thin clients in 
your environment (see "Central Configuration: Automating Configurations").  
In addition, the Wyse USB Firmware Tool also provides a simple USB imaging solution for 
supported devices (see "Enhancing Your Experience with Wyse Software").
• "Accessibility"
• "Appearance"
• "Background"
• "Date & Time"
• "Device Settings"
• "Diagnostics"
• "Display"
• "Ericom PowerTerm® TEC (Managing Servers Available for Connections)"
• "Citrix Settings (Global Settings)"
• "Import Certificates"
• "INI (Source) Settings"
• "Keyboard"
• "Language Support"
• "Mixer"
• "Mouse"
• "Network Connections"
• "Network Proxy"
• "Printers"
• "RDP Settings"
• "Screensaver"
• "TCX Audio"
• "TCX USB Virtualizer"
• "User Administration"
• "VNC Server"
• "WDM"
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12 Chapter 3
Accessibility 
Use the Accessibility dialog box (click Accessibility) to set Sticky Keys, Slow Keys, and 
Bounce Keys options.

Appearance 
Use the Appearance dialog box (click Appearance) to customize your Home screen 
(Style, Icons, and Fonts).
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Configuring System Settings 13
Background 
Use the Background dialog box (click Background) to customize your desktop 
background.

TIP: PNG files are recommended for most single monitor setups. However, on 
dual-monitor setups, a JPG file is recommended (as there is some color variance due to 
Y-Cable or DVI/VGA output when using PNG files).
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14 Chapter 3
Citrix Settings (Global Settings)
Use the Citrix Settings dialog box (click Citrix Settings) to configure the common 
settings you want for all ICA connections (ICA Global Settings). After configuring, be sure 
to click OK.

Network
Use the Network tab to configure the servers and reconnection settings. 

Use the following guidelines:
• PN Agent Server - Enter the PN Agent Server you want to use (this can be a list of 

servers with each server separated by a semi-colon).
• Metaframe Server - Enter the Metaframe Server you want to use (this can be a list of 

servers with each server separated by a semi-colon).
• Browsing Protocol - Select the browsing protocol to use from the list.
• PN Logon Domains - Enter the PN Logon Domains, and then select your PN Login 

Method and PN Desktop Setup settings.
• Window Style - Select Seamless to display the connection in a seamless window.
• Application Reconnection - Select the Automatic reconnection at logon check box 

to enable reconnection, and then select the connect option you want. 
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Configuring System Settings 15
Drive Mapping
Use the Drive Mapping tab to map drives on the server to devices on the thin client, and to 
view and manage (add, edit, and delete) the list of current drives (including drive 
information) mapped on the thin client.

Adding Drives
1. Clear the Dynamic Mapping check box, and then click Add to open the Citrix Drive 

Map dialog box.

2. Select a drive letter (A to Z) from the Drive Letter list.

3. To enable or disable reading and writing for the drive, select or clear the Enable Read 
and Enable Write check boxes.

4. Select a drive type (USB Floppy, USB CDROM, USB Disk or Memory Stick, or 
Local or Mounted Disk) from the Drive Type list.

5. (Optional) Enter the directory on the USB device to access in the Base Directory text 
box.

6. Click OK to add the drive to the list of available drives.

Editing and Deleting Drives
To edit or delete a drive, select a drive from the list of available drives and do one of the 
following:
• Edit - Click Edit and configure the drive as described in "Adding Drives."
• Delete - Click Delete to remove the drive.
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Hotkeys 
Use the Hotkeys tab to map hotkeys on the thin client (select a Hotkey option using the 
Hotkey lists for each function you want).

Display 
Use the Display tab to set:
• Mouse - Enables the middle mouse button to paste copied content.
• Scroll Adjustment - If you encounter over-scrolling when using certain published 

applications, increase the adjustment by 100 until the display improves (maximum 
scroll adjustment is 1000).

• PrintScreen - Select to use the Print Screen key to capture an image of the screen to 
the Clipboard (used for ICA XCapture support). If the check box is selected, a 
message appears warning about the influence of this setting on other applications).
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Firewall 
Use the Firewall tab to set the firewall options on the thin client:
• Automatically detect proxy - Detects proxy servers automatically.
• Use Alternate Address for Firewalls - Enables connections behind a firewall 
• Proxy Type - Select a Proxy Type from the list and if necessary (Secure (HTTPS) or 

SOCKS, enter the Proxy Address and Port).

Trusted Server Configuration 
Use the Trusted Server Configuration tab to set and enforce the trusted server 
configuration. To enforce a trusted server configuration, select the Enabled option, select 
the Enforce trusted server configuration check box, enter the Address of the trusted 
server, and then click OK (you can also use the Enabled or Disabled options to quickly 
enable or disable the enforcement configuration). 
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Date & Time
Use the Date/Time Properties dialog box (click Date & Time) to set Date & Time and 
Time Zone options. After configuring, be sure to click OK.

Use the Date and Time tab to: 
• Synchronize with a Network Time Protocol (NTP) server - Enter the IP Address or 

hostname of the NTP server (the current NTP server is shown) to synchronize the 
clock time and date of the thin client. You can also use Add, Edit, and Delete to 
manage your list of NTP servers available. 

• Manually set the date and time - Clear the Synchronize date and time over the 
network check box, and then select your date and time settings.

Use the Time Zone tab to select your time zone and whether or not to automatically 
enable daylight savings time (select or clear the System clock uses UTC check box).
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Device Settings
Use the Device Settings dialog box (click Device Settings) to set the parameters of your 
device (Terminal Name, Hosts, and Ethernet Speed). After configuring, be sure to click 
OK.

Terminal Name
Use the Terminal Name tab to obtain the device name:
• Contact DHCP server - Obtains the name from the DHCP server.
• Derive from MAC address - Generates the name from the device MAC address.
• Use the following name - Allows you to manually enter a name.

Hosts
Use the Hosts tab to add mappings of IP addresses to hostnames that are not available 
through DNS (the names of mapped addresses appear on the Hosts tab): 
• Adding an IP address - Click Add to open the /etc hosts entry dialog box, enter an 

IP Address, Hostname, Aliases (optional), and then click OK.
• Editing a Host - Select a host from the list, click Edit, and configure the host.
• Deleting a Host - Select a host from the list, click Delete, and confirm.
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Ethernet Speed
Use the Ethernet Speed tab to select the Ethernet speed.

TIP: It is recommended to use Auto-Detect in a 1 GB network.

Diagnostics
Use the Diagnostics dialog box (click Diagnostics) to select and use a diagnostic tool:
• Ping - Enter or select a destination from the Destination list and click Ping.
• Trace Route - Enter or select a destination from the Destination list and click Trace 

Route (diagnostic information appears on the Trace Route tab).
• Temporary Settings - View the temporary settings of the thin client.
• Permanent Settings - View the permanent settings of the thin client.
• wlx.ini/wnos.ini - View the wlx.ini or wnos.ini file as copied to the thin client.
• user.ini - View the user.ini file as copied to the thin client.
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Display 
Use the Monitor Preferences dialog box (click Display) to set the monitor display 
preferences (Primary Display Output, Resolution, Refresh Rate, and Rotation). For most 
monitors, resolution is obtained automatically from the monitor. After configuring, be sure 
to click Apply.

TIP: Dual Monitors - When using a DVI to DVI/VGA splitter with VGA and DVI monitors at 
the same time, note that the VGA monitor will be the primary monitor.

TIP: Single-monitor resolution - Maximum is 1920x1080 (16:9); Minimum is 640x480 (4:3).  
Dual-monitor resolution - Maximum is 1280x1024 (5:4); Minimum is 720x400 (9:5).

Ericom PowerTerm® TEC (Managing Servers Available for Connections)
• Use the Ericom PowerTerm Terminal Emulation dialog box (click Ericom 

PowerTerm) to view and manage (add and delete) the list of servers that are 
presented when an Ericom PowerTerm® TEC connection is being configured for thin 
client access to network resources as described in "Ericom PowerTerm® TEC."

Use the following guidelines:
• Adding a hostname - Click Add to open the Add host dialog box, enter a Hostname, 

and then click OK. The hostname is added to the Hostname list.
• Deleting a hostname - Select a hostname and click Delete. The hostname is removed 

from the Hostname list.
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INI (Source) Settings 
Use the INI Settings dialog box (click INI Settings) to direct the thin client to the source 
(server location) of INI files. 
CAUTION: It is recommended to obtain INI files through a DHCP server using DHCP 
options rather than through a static IP address. For information about how INI files are 
downloaded from a server, see "How to Set Up Automatic Configuration." 
TIP: Wyse devices also support INI changes through Wyse Device Manager’s DDC (see 
"Enhancing Your Experience with Wyse Software" and "WDM").

Use the following guidelines:
• Do not use INI files - Use this option when you want to use only locally configured 

settings (using the thin client dialog boxes available) and do not want to use available 
INI files on the network or local INI files.

• Use INI files from server only - Use this option when you want to use INI files from 
the specified server only (for example, you do not want to use local INI files or do not 
want to allow INI use when disconnected from the server for security reasons). When 
using this option you can direct the thin client to the server location through either of 
the following ways:
· DHCP Server - Select the Get INI and Upgrade server details via DHCP check 

box. The DHCP server will direct the thin client (using DHCP options) to the server 
location where the INI files reside.

· Manually entered server address - Clear the Get INI and Upgrade server 
details via DHCP check box and enter the static INI Settings (INI Server URL, and 
optionally the Username and Password of the server, if selecting the Server 
requires authentication check box).

• If server is available, use INI files from server only; otherwise use local INI files - 
Use this option when you want to use INI files from the specified server, however, local 
INI files can be used if that server is unavailable. When using this option you can direct 
the thin client to the server location through either of the following ways:
· DHCP Server - Select the Get INI and Upgrade server details via DHCP check 

box. The DHCP server will direct the thin client (using DHCP options) to the server 
location where the INI files reside.

· Manually entered server address - Clear the Get INI and Upgrade server 
details via DHCP check box and enter the INI Settings (INI Server URL, and 
optionally the Username and Password of the server, if selecting the Server 
requires authentication check box).

• Use local INI files only - Use this option when you want to use only local INI files and 
do not want to use available INI files on the network.

TIP: INI files can be cached locally if using the EnableLocal and LocalCopy INI 
parameters; see Reference Guide: Wyse ® Enhanced Ubuntu™ Linux INI Files.
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Import Certificates
Use the Import Certificates dialog box (click Import Certificates) to import and manage 
(add and delete) ICA Digital Certificates as described in "Adding Certificates from a 
Remote Server" and "Adding Certificates from a Local Device."

Adding Certificates from a Remote Server
Use the following guidelines (certificate files you add from a remote server must end with 
the extension .crt, and be DER-encoded or Base64-encoded):

1. In the Import Certificates dialog box, click Add to open the Add Certificate dialog 
box.

2. Select the Remote Server option, and then click Next to open the Certificate Import 
Server Settings dialog box.

3. Select the Remote Certificate Source server option that contains the certificate you 
want. If you select the Use the following Server option, enter the Import Server URL 
(supported protocols are ftp, http, and https) and the User name, and Password 
required for that server.

4. Select the certificate file from the Certificate file list (if the Import Server URL, User 
name, and Password are entered correctly, this list automatically displays the names of 
available certificates on the server).

5. After the configuring the Remote Certificate Source server option you selected, click 
Add.
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Adding Certificates from a Local Device
1. In the Import Certificates dialog box, click Add to open the Add Certificate dialog 

box.

2. Select the Local Server option, and then click Next to open the Open File dialog box.

3. Use the folders and command buttons to find and select the certificate you want to use.

Keyboard
Use the Keyboard dialog box (click Keyboard) to select Behavior (repeat key and cursor 
blinking options), Application Shortcuts (add/remove shortcuts for launching applications 
and reset to defaults options), and Layout (keyboard models and layout options).

TIP: For information on available Home screen keyboard shortcuts, see "Home Screen 
Keyboard Shortcuts."
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Language Support
Use the Language & Text dialog box (click Language Support) to select the Language 
and Text format options of the User Interface (UI) from the list of supported languages. 
Note that currently only English is supported.

Mixer
Use the Mixer dialog box (click Mixer) to configure Playback (Master system sounds) 
volume and other available controls. 

Select the Sound Card option you want and use the Select Controls dialog box (click 
Select Controls) to select the check boxes of the audio controls you want visible (tabs) in 
the Mixer dialog box (available for configuration). For example, you can display a capture 
sound card option (for recording sounds), output sound card (with playback, capture, and 
switches preferences), and so on.

TIP: Clicking the volume button toggles the mute on and off. 
Clicking the link button toggles the select-all-sliders feature (all sliders move as one) on 
and off. 
Clicking the record button toggles the record sound on and off.

TIP: For these settings to take effect, sound must be supported and enabled on the server 
used for ICA connections, RDP connections, or MPlayer. Sound requires significant 
bandwidth that may not be available on some WAN and dial-up connections.
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Mouse
Use the Mouse dialog box (click Mouse) to select Devices (button order, feedback, and 
reset to defaults options) and Behavior (drag-and-drop and double-click options) mouse 
preferences.

Network Connections
Use the Network Connections dialog box (click Network Connections) to configure the 
settings you want for supported network connections. Use the Wired, Wireless, Mobile 
Broadband, VPN, and DSL tabs to view and manage (add, edit, and delete) the list of 
network connections configured on the thin client. By default, your thin client obtains 
information from the DHCP server about network connections (highly recommended), but 
you can manually enter connection information (provided by your network administrator) 
to connect to other networks (experienced users only). 
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Network Proxy 
Use the Network Proxy Preferences dialog box (click Network Proxy) to configure the 
Proxy Configuration and Ignored Hosts options you want for supported network 
connections. Use the Proxy Configuration and Ignored Hosts tabs to view and manage 
proxy settings and list of hosts to ignore (information provided by your network 
administrator) for the network connections configured on the thin client (experienced users 
only). 
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Printers
Use the Printers dialog box (click Printers) for printer related tasks. 

TIP: While this section provides an overview of printer related guidelines to use, see 
"Installing a Network Printer" and "Installing a Local Printer" for detailed procedures. For 
full details on Linux printing, refer to CUPS documentation.

Use the following guidelines: 
• CUPS and Home tabs - View and access CUPS information (click the CUPS tab or the 

Home tab) - CUPS is the standard-based, open source printing system developed by 
Apple Inc. for Mac OS® X and other UNIX® -like operating systems.

• Administration tab

Printers:
· Add Printer - Add and configure a network or local printer (click the 

Administration tab > Add Printer to open and use the Add Printer wizard). See 
"Installing a Network Printer" and "Installing a Local Printer" for detailed procedures.

· Find New Printers - Find available printers for use.
· Manage Printers - View the list of currently configured printers (click 

Administration tab > Manage Printers). In addition, you can: 
Select the default printer (select a printer in the list and click Printer > Set as 
Default). Note that administrators can specify system-wide and personal default 
printers. 
Change printer settings (right-click a printer in the list, select Properties, and then 
click Settings). 
Change printer policies (right-click a printer in the list, select Properties, and then 
click Policies). 
Change user access to the printer (right-click a printer in the list, select Properties, 
and then click Access Control). 
Change printer job options (right-click a printer in the list, select Properties, and 
then click Job Options). 
Delete a printer (right-click a printer in the list, select Delete, and click OK).

Classes: 
· Add Class - Add and configure a Class of printers (click the Administration tab > 

Add Class to open and use the Add Class wizard).
· Manage Classes - View the list of currently configured Classes of printers (click 

Administration tab > Manage Classes). 
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Jobs: 
· Manage Jobs - Change printer job options (click Administration tab > Manage 

Jobs).

Server: 
· Edit Configuration File - Change the server configuration file (click 

Administration tab > Edit Configuration File). 
· View Access Log - View the access log to the server (click Administration tab > 

View Access Log). 
· View Error Log - View the error log to the server (click Administration tab > View 

Error Log). 
· Advanced Check Boxes - Select or clear the check boxes you want in the 

Advanced list; after making your selections, be sure to click Change Settings.

RSS Subscriptions: 
· Add Subscription - Add and configure an RSS subscription (click the 

Administration tab > Add Subscription to open and use the Add RSS 
Subscription wizard).

• Classes tab - Search for printers of a class type.
• Online Help tab - Access CUPS online help interface.
• Jobs tab - Search and display printing jobs.
• Printers tab - Search and display printers (with printer details).

Installing a Network Printer
1. Click Administration tab > Add Printer to open the Add Printer wizard.

2. Select the printer option you want from the Discovered Network Printers or Other 
Network Printers lists and follow the Add Printer wizard using the following guidelines:
• AppSocket/HP JetDirect - Use this option for a printer connected directly to the 

network instead of through a computer.
• Internet Printing Protocol (IPP) - Use this option for a printer attached to a 

different Linux system on the same network running CUPS or a printer configured 
on another operating system to use IPP (http printing).

• Internet Printing Protocol (HTTP) - Use this option for a printer attached to a 
different Linux system on the same network running CUPS or a printer configured 
on another operating system to use HTTP (ipp printing).

• LPD/LPR Host or Printer - Use this option for a printer attached to a different UNIX 
system that can be accessed over a TCP/IP network (for example, a printer 
attached to another Linux system on your network) or a thin client used as an LPD 
(Line Printer Daemon) server for LPD printing requests from the network. You can 
enter the DNS or WINS name of the server for the network printer, or an IP address 
can also be entered. Note that if the printer is attached to another thin client on your 
network, the entry in the Host box is the name or address of that thin client.
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Installing a Local Printer
Connect the printer cable to your thin client and use the following guidelines:

1. Click Administration tab > Add Printer to open the Add Printer wizard.

2. Be sure the USB printer you connected to your thin client is selected and click 
Continue.

TIP: You can use the Serial Port # 1 and Serial Port # 2 options as needed for your 
local serial port printers.

3. Select the option with which you want to obtain your printer driver and click Continue.

4. Select the Model and Driver and click Continue.

5. Enter the Printer Name, Description, Location, and then click Apply. The printer is 
added to the Manage Printers list (click Administration tab > Manage Printers) and 
is ready for use.
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RDP Settings
Use the RDP Settings dialog box (click RDP Settings) to configure the common settings 
you want for all RDP connections. After configuring, be sure to click OK.

RD Broker
Use the RD Broker tab to configure the servers and reconnection settings for login usage. 

Use the following guidelines:
• RD Broker Server - Enter the RD Broker Server you want (this can be a list of servers 

with each server separated by a semi-colon).
• Logon Domains - Enter the Logon Domains, and then select your Verify SSL 

Certificate and Verify Host in SSL Certificate settings.

Window 
Use the Window tab to select the Window Size you want, and to disable the panel (if you 
want the window to appear without the panel while using the connection).
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Screensaver
Use the Screensaver Preferences dialog box (click Screensaver) to Display Modes 
(select screen saver theme settings) and Advanced (display power management) 
settings. 

TIP: Press the Power button to wake the computer from standby or sleep mode.

TCX Audio
Use the Audio Devices dialog box (click TCX Audio) to view and change the 
automatically-detected audio device (for example, a connected audio headset/device will 
be automatically detected) you want to use for your audio output (select the Audio device 
you want and click OK). 
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TCX USB Virtualizer
Use the TCX USB Virtualizer Configuration Utility dialog box (click TCX USB 
Virtualizer) to view and manage (add, edit, and delete) the list of current device classes 
(on the Configuration tab) and to view the list USB devices enabled or denied for use on 
the thin client (on the USB Devices tab). You can deny a device class, but still permit a 
USB device in that class to be used, by adding it to the Devices list of the Configuration 
tab.

Use the following guidelines:
• Enabling USB devices - Select the Enabled check box.
• Allowing or denying USB device classes - On the Configuration tab, select or clear 

the check box of a device class in the Devices list to allow or deny its use. For 
example, select Smart Card Devices to permit USB smart card devices to be used to 
log into virtual machines.

• Adding a USB device - On the Configuration tab, click Add to open the Add dialog 
box, enter a Device Name, select a class for the device from the Class list, enter the 
Sub Class, Vendor ID, Protocol, and Product ID, and then click Add. After you reboot 
your thin client, the name of the new device appears on the Configuration tab. 
TIP: You can obtain device Class, Sub Class, Protocol, Vendor ID, and Product ID 
information by plugging the device into the USB port of your thin client and viewing the 
information displayed in the USB Devices tab.

• Allowing or denying a USB device - After you add a USB device, its name appears 
on the Configuration tab. Select or clear a USB device check box to allow or deny its 
use.

CAUTION: Use caution when using TCX USB Virtualizer on a terminal server, as allowing 
use of a USB device is global and not session restricted.

For information on the TCX USB Virtualizer component of Wyse TCX Suite software, refer 
to "Enhancing Your Experience with Wyse Software."
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User Administration
Use the User Administration dialog box (click User Administration) to view and edit 
passwords for all users (built-in defaults) and to enable automatic login for a user 
(automatically log in a user at system start up). In addition, you can manage SSH root 
User password and login (using the SSH root User tab).

CAUTION: While this dialog box allows you to edit the passwords and automatic login for 
users of the thin client, you must use central configuration (INI files) to add or delete users 
beyond the built-in default users provided. In general, it is recommended that you use 
user.ini files to manage users for normal use cases. For example, a new user should be 
created through a user.ini file with the appropriate privilege level defined in the text file. 

To edit a user password, select the change password check box you want, and then enter 
a new password in the New Password and Confirm Password boxes.

TIP: The Users tab can be a convenient way to locally change the password and enable 
automatic login for a specific user.

VNC Server
Use the VNC Server Settings dialog box (click VNC Server) to enable and disable the 
VNC server, and to use and change the server password. 

TIP: The VNC server is enabled by default.
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WDM
Use the WDM Agent Configuration dialog box (click WDM) to configure the Wyse Device 
Manager server location. 

TIP: It is recommended that after configuring, you reboot the thin client.

To configure the WDM server location:

1. Enter the WDM Server IP address.

2. Enter the Non-secure Port (HTTP) for client to server communication (default, is 80).

3. Enter the Secure Port (HTTPS) for client to server communication (default is 443).

4. Select the Discovery Settings you want. For more information on WDM, see your WDM 
documentation.

5. Click OK.

TIP: Note that you can also configure the Wyse Device Manager server location through 
INI files (wlx.ini) or the DHCP Option tag 186 (see "Central Configuration: Automating 
Configurations"). 
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4 Configuring Connections

This chapter provides instructions on configuring and adding connections to your Home 
screen for use (to access the enterprise server environment available to the thin client). 

TIP: While it is not recommended to use dialog boxes for configuring connections for thin 
client use, they are available in case you want to temporarily override central default 
configurations in some cases or you do not have the option to set up central configuration 
(smaller environments). In general, it is recommended that you use central configuration 
to enable you to automatically push any desired default configuration to all supported thin 
clients in your environment (see "Central Configuration: Automating Configurations"). 
In addition, the Wyse USB Firmware Tool also provides a simple USB imaging solution for 
supported devices (see "Enhancing Your Experience with Wyse Software").

Clicking Enter Edit Mode > Add Item on the Home screen opens the Connection 
Manager. Use the Connection Manager to add the following items to your Home screen 
for use (high privilege users only):

• "Citrix"
• "Custom"
• "Ericom PowerTerm® TEC"
• "RDP"
• "SSH"
• "VMware View Client"
• "VNC Viewer"
• "Web Browser"
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Citrix
Use the Citrix Connection Settings dialog box (click Citrix) to set Citrix client connection 
configurations. After configuring, be sure to click OK.

TIP: When using multiple Citrix connections, you can use the ICA Connection Center to 
manage open Citrix connections. For information on using multiple Citrix connections, 
refer to the Wyse Knowledge Base on the Wyse Web site.

Network 
Use the Network tab to configure the network settings:
• Server or Published Application - Select an option for making the connection.
• Description - Enter a name/label for the connection.
• Network Protocol - Select a network protocol.
• Browser Server - Enter the Browser Server name (this can be a list of server names 

with each name separated by a semi-colon). 
TIP: You do not need to enter a browser server name if you do not want to connect to 
either a published application or a server by name. In addition, generating an ICA 
connection to a server using a server name in the Server text box for the connection 
does not require a Browser Server address, as long as the DNS information is properly 
entered.

• Server or Application Name - Select a server from the Server list or a published 
application from the Application Name list. If needed, click Refresh to refresh the list of 
servers or published applications. 
TIP: You can enter only the IP address of the target server as long as there is no need 
to resolve a name.
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Connection
Use the Connection tab to configure the connection settings:
• Enable compression - Enables compression.
• Low bandwidth - Enables low-bandwidth optimization.
• Enable sound - Enables sound.
• Ping before connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Enable Middle Button Paste - Enables middle button paste for the mouse.
• Encryption - Select an encryption type (default is Basic).

Window 
Use the Window tab to select the Window Colors and the Window Size you want, and to 
disable the panel (if you want the window to appear without the panel while using the 
connection).

Application 
Use the Application tab to enter the command line and Working Directory of the 
application (if you selected the Published Application option on the Network tab):
• Command Line - Enter the command line for the program on the server.
• Working Directory - Enter the working directory for the program.

Login 
Use the Login tab to configure credentials used to automatically log in to the server:
• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain - Enter the domain name.
• Serial Number - Enter the serial number for Metaframe environments that require the 

thin client license serial number.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.

TIP: The User Name, Password, Domain, and Serial Number fields are optional. If the 
User Name, Password, and Domain fields are blank, interactive login is required (users 
must enter the information at login time).

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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Firewall 
Use the Firewall tab to configure an alternate address for firewalls:
• Automatically detect proxy - Select to automatically detect the proxy type.
• Use Alternate Address for Firewalls - Select Yes to use an alternate address for 

firewalls.
• Proxy Type - Select a proxy type.
• Proxy Address and Port - If you select Secure (HTTPS) or SOCKS as the Proxy 

Type, you must enter the Proxy Address and Port.

TIP: Published applications do not support Firewall functions.
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Custom
Use the Custom Connection Configuration dialog box (click Custom) to set custom 
connection configurations. After configuring, be sure to click OK.

Application
Use the Application tab to configure:
• Description - Enter the description.
• Command Line - Enter the command line for the program on the server.
• Run in terminal window - Runs the application in a terminal window (use with 

applications that require a terminal window such a console program).
• Auto Connect - Starts the connection automatically after system startup.

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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Ericom PowerTerm® TEC 
Use the Terminal Emulator Configuration dialog box (click Ericom PowerTerm) to set 
Ericom PowerTerm client connection configurations. After configuring, be sure to click OK. 

Network 
Use the Network tab to configure the network settings:
• Network Connection or Serial Connection - Select Network Connection for 

connections over TCP/IP, or Serial Connection for connections through a serial port.
• Description - Enter a description for the connection.
• Host - Enter a host name or IP Address (or select one from the list). Host can be 

populated from the global Ericom — PowerTerm® TEC connection application.
• Port - Enter the port of the host.
• Terminal Type - Select a terminal type.
• Terminal Name - Enter a name for the terminal.
• Save Configuration Locally - Saves the font, color, key-mapping and other settings of 

the Ericom — PowerTerm® TEC application locally.

Window 
Use the Window tab to select the Window Size you want.

Connection 
Use the Connection tab to configure the connection settings:
• Auto Connect - Starts the connection automatically after system startup.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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Setting 
Use the Setting tab to automatically run script during user logon (enter the script name 
and path).

Remote Configuration 
Use the Remote Configuration tab to configure:
• Remote Configuration Filename - Enter the remote configuration filename for the 

connection.
• Remote Configuration Path - Enter the remote configuration path for the connection.

View 
Use the View tab to select the items that will appear when using the connection (menu, 
toolbar, status bar, and buttons).
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RDP
Use the Remote Desktop Protocol (RDP) Client Settings dialog box (click RDP 
Settings) to set RDP connection configurations. After configuring, be sure to click OK.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a name/label for the connection.
• Server - Enter a server name or IP address.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Notify When Disconnected - Notifies you when the connection is broken.

Window 
Use the Window tab to select the Window Colors and the Window Size you want, and to 
disable the panel (if you want the window to appear without the panel while using the 
connection).

Login 
Use the Login tab to configure credentials used to automatically log in to the connection:
• Use smart card - Enables the use of a smart card when connecting.
• Network Level Authentication - Enables the use of Network Level Authentication 

(NLA) when connecting. Be sure to enable NLA if NLA is enabled on your remote 
computer (your remote computer requires NLA user authentication before you 
establish a full Remote Desktop connection and the logon screen appears).

• Use RD Gateway settings - Enables the use of Remote Desktop Gateway (RD 
Gateway) server when connecting. If required, then enter the IP address or URL of the 
RD Gateway server. You can also enable Use Remote Desktop Credentials for RD 
Gateway (if the server credentials are the same credentials as your Remote Desktop 
Credentials (Host remote computer credentials) in the User Name, Password, and 
Domain fields below) or disable Use Remote Desktop Credentials for RD Gateway 
and enter the RD User Name, RD Password, and RD Domain of the RD Gateway 
server if required. 
NOTE: An RD Gateway server is a type of gateway that enables authorized users to 
connect to remote computers on a corporate network from any computer with an 
Internet connection. An RD Gateway server enables Remote Desktop connections to a 
corporate network from the Internet without having to set up virtual private network 
(VPN) connections. Ask your network administrator whether you need to specify an RD 
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• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain - Enter the domain name.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.

TIP: The User Name, Password, and Domain fields are optional. If you leave any of these 
fields blank, interactive login is required (users must enter the information at login time).

Connection 
Use the Connection tab to configure the connection settings:
• Compression - Enables compression.
• NT4 compatible - Enables RDP protocol version 4.
• Low bandwidth - Enables low-bandwidth optimization.
• Sound - Select audio source for the connection (Local or Remote).
• Encryption Level - Select an encryption level (Normal or None). 

TIP: For servers with data encryption settings, you must select Normal for the 
encryption level.

Experience 
Use the Experience tab to configure the experience settings for a user desktop:
• Speed Level - Select a speed level to describe the network connection.
• Desktop Background - Displays the desktop background. 
• Font Smoothing - Enables font smoothing (smooth type).
• Menu and window animation - Enables menu and window animation.
• RemoteFX - Enables a a RemoteFX session. To use an RDP USB redirection type you 

must use a RemoteFX session (RDP USB is not supported using a standard RDP 
session). 

• Show contents of window while dragging - Shows the window content when the 
user drags the window on screen.

• Subsampling - Enables color space conversion required for chroma subsampling ( the 
practice of encoding/compressing images for a higher transmission experience).

TIP: Consider your network restrictions when selecting options on the Experience tab. For 
example, be sure to configure appropriately for your bandwidth level and so on.

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).

Application 
Use the Application tab to enter the command line and Working Directory of the 
application that will run at the beginning of a session:
• Command Line - Enter the command line for the program on the server.
• Working Directory - Enter the working directory for the program.
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Drive Mapping 
Use the Drive Mapping tab to map share names on the server to USB mass storage 
devices attached to the thin client, and to view and manage (add, edit, and delete) the list 
of current server share names (including drive information) mapped on the thin client.

Adding Share Names
1. Click Add to open the RDP Drive Map dialog box.

2. Enter a Share Name.

3. Select a Drive Type (USB Floppy, USB CDROM, USB Disk or Memory Stick, or 
Local or Mounted Disk).

4. (Optional) Enter the directory on the USB device to access in the Base Directory text 
box.

5. Click OK to add the Share Name to the list of available Share Names.

Editing and Deleting Share Names
To edit or delete a Share Name, select a Share Name from the list of available Share 
Names and do one of the following:
• Edit - Click Edit and configure the Share Name as described in "Adding Share 

Names."
• Delete - Click Delete to remove the Share Name.
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Device Mapping 
Use the Device Mapping tab to map devices to ports on the thin client, and to view and 
manage (add and delete) the list of current devices (including device information) mapped 
on the thin client.

Adding Devices
1. Click Add to open the Add Port Mapping dialog box.

2. Select a port from the Port list.

3. Select the directory of the device to access from the Device list. 

4. Click OK to add the device to the list of available devices.

Deleting Devices
To delete a device, select a device from the list of available devices and click Delete.
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SSH
Use the SSH Configuration dialog box (click SSH) to set SSH connection configurations. 
After configuring, be sure to click OK.

TIP: X forwarding/tunneling is automatic and allows you to execute remote X applications.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a name/label for the connection.
• Host - Enter a host name or IP address.
• Remote Username - Enter a username.
• Remote Command - Enter the command to execute on the server.

Connection 
Use the Connection tab to configure the connection settings:
• Auto Connect - Starts the connection automatically after system startup.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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VMware View Client 
Use the VMware View Client Settings dialog box (click VMware View Client) to set 
VMware View Client connection configurations. After configuring, be sure to click OK.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a name/label for the connection.
• Host - Enter the VMware View Server location (either host name, a full URL including 

the root path, or an IP Address). 
• Port - Enter the port of the host.
• Use Secure Connection (SSL) - Select to use an SSL connection.
• Enable interactive mode - Enables interactive mode.

Secure Preferences
Use the Secure Preferences tab to select the option you want that determines how the 
client will proceed when it cannot verify that your connection to the server is secure.  
CAUTION: It is not recommended that you change this setting unless instructed to do so 
by your system administrator.

Connection 
Use the Connection tab to configure the connection settings:
• Protocol - Select a network protocol.
• Disable 32 bit color on RDP - You can select this check box if you selected RDP for 

the Protocol.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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Desktop 
Use the Desktop tab to select whether to use full screen or a display size on all monitors, 
to disable the panel (if you want the window to appear without the panel while using the 
connection), to disable the menu bar on full screen, and to disable Exit on disconnect.

Login 
Use the Login tab to configure credentials used to automatically log in to the connection:
• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain Name - Enter the domain name.
• Desktop - Enter the desktop name.
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VNC Viewer
Use the VNC Viewer Settings dialog box (click VMware Viewer) to set VNC Viewer 
connection configurations. After configuring, be sure to click OK.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a name/label for the connection.
• Host - Enter a host name or IP address.
• Connect to - Select a connection type of either Display number (enter the display to 

connect to on the server) or Port number (enter the port to connect to on the server).
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.

Connection 
Use the Connection tab to configure the connection settings:
• Compression Level - Select a compression level for encoding.
• Shared - Enables or disables a shared connection.
• View Only - Blocks mouse and keyboard events for a view-only connection.

Window 
Use the Window tab to configure window settings:
• Full Screen - Opens the connection in a full-screen window.
• Disable Panel - Disables the panel while using the connection.
• Color Depth - Controls how many colors to display with each on-screen pixel.
• JPEG Quality - Specifies the image quality for encoding.

Login 
Use the Login tab to configure credentials used to automatically log in to the VNC server:
• Password - Enter the password to connect to the VNC server.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.
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Web Browser 
Use the Web Browser Configuration dialog box (click Web Browser) to set Web 
Browser connection configurations. After configuring, be sure to click OK.

Network 
Use the Network tab to configure the description and URL (optional if you want the 
browser to open to a particular Web page each time you connect). If you want the browser 
to launch automatically after system startup, select the Auto Connect check box.

Window 
Use the Window tab to configure how the browser window is displayed. If you want the 
browser to appear in fullscreen mode without any menus or toolbars, select Kiosk Mode. 
If you want the browser to appear without the panel while using the connection, select 
Disable Panel. If you are not using Kiosk Mode, you can select the Window Size you want 
from the list.

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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A Central Configuration: Automating 
Configurations
This appendix describes how to set up your environment to provide your thin clients 
running Wyse Enhanced Ubuntu Linux with automatic configurations in three simple 
steps. 

It includes:
• "How INI Files are Employed"
• "How to Set Up Automatic Configuration"

TIP: Wyse thin clients do not require device management software. They are configured to 
obtain their IP address, as well as the location of configuration instructions, from a DHCP 
server. However, you can use Wyse Device Manager (WDM) for a more hands-on 
management of your thin clients. For information about configuring your thin clients to 
communicate with a WDM server, see "WDM" and related INI parameters in Reference 
Guide: Wyse ® Enhanced Ubuntu™ Linux INI Files. 

How INI Files are Employed
INI files (created and maintained by the administrator) determine how the thin client is 
configured. The thin client accesses INI files from the server during the initialization 
process. Typically, INI files are accessed through FTP, HTTP, and HTTPS; if no protocol is 
specified, the default is anonymous FTP.

INI files are employed as follows: 
• wlx.ini - This is the global INI file. One wlx.ini file is available to all users. It contains 

global parameters for all thin clients accessing the server. If the operating system 
cannot find wlx.ini, it defaults to wnos.ini.

• {username}.ini - This file is unique to each user. The {username}.ini file contains the 
connection profile for each user. Parameters in the user profile generally supersede 
the identically named global parameters.

• $MAC.ini - This file can be used for device-specific configuration. If the thin client 
locates this INI file (it is stored in the same directory as wlx.ini), wlx.ini is not accessed, 
unless you use the include=wlx.ini parameter.

When a thin client is initialized, it accesses the global wlx.ini file. When a user logs in, the 
thin client accesses the user’s unique {username}.ini file. For detailed information on 
constructing and using Wyse Enhanced Ubuntu Linux INI files, refer to Reference Guide: 
Wyse ® Enhanced Ubuntu™ Linux INI Files.

TIP: If both PNLite and a user profile are being used, the username must be defined in the 
Windows domain to be used, and the password must be the same for the domain and the 
profile.
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How to Set Up Automatic Configuration
For a Wyse thin client running Wyse Enhanced Ubuntu Linux to successfully access INI 
files and configure itself from a server, you must set up the server with the correct folder 
structure (where the INI files and other files are located), direct the thin client to the server, 
and then reboot or start the thin client. 

After DHCP and servers are configured and available, the thin client checks (at each boot 
up) to see whether or not any configuration changes are available on a predefined server 
(DCHP Option #161 specifies the server URL, DCHP Option #162 specifies the root path 
to the server). If configuration changes are available, the changes are automatically 
installed.

Step 1: Prepare the Root Directory and Folder Structure on the Server
Set up the following folder structure on your server under the C:/inetpub/ftproot folder (for 
FTP) or C:/inetpub/wwwroot folder (for HTTP or HTTPS) and place your INI files and other 
necessary files inside the structure as noted (this list describes the folder structure, 
starting with the root directory). 
/wyse/ The root directory. It stores the wlx folder and the addons folder.

/wyse/wlx The main INI configuration folder. It stores the following: 
• wlx.ini file or $MAC.ini file
• bitmap folder
• certs folder
• ini folder

/wyse/wlx/bitmap The folder where you can place custom images you plan to use.

/wyse/wlx/certs The folder where you can place the CA certificates that can be 
imported to a thin client. 
Note: Use the Certs and ImportCerts INI parameters in the wlx.ini 
file to import the certificates to thin clients.

/wyse/wlx/ini The folder where you can place the {username}.ini files.

/wyse/addons The folder where you can place the add-ons you want to use. 
It also stores the directory file and the *.deb packages available 
to be installed on the thin client. The directory file should list all 
available add-ons. The directory file is required in the addons 
folder to guarantee that add-ons are properly located.
NOTE: If you want to do an update with the Preserve changes 
option enabled, ensure that your addons folder includes a copy of 
your current add-ons. The system may require two reboots to 
fully update the add-ons while preserving local changes.
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Be sure to create/activate the two required MIME Types (.ini and .) under IIS (on a per site 
basis) to enable downloading. Also be sure your Web server can identify the file types 
used by Wyse thin clients.

To create/activate the .ini MIME Type:

1. On your IIS server, use the File Types menu to add a New Type.

2. In the File Type dialog box, enter the Associated extension .ini and Content type 
(MIME) text/plain.

3. Click OK to apply the settings.

To create/activate the . MIME Type: 

1. On your IIS server, use the File Types menu to add a New Type.

2. In the File Type dialog box, enter the Associated extension . and Content type (MIME) 
text/plain.

3. Click OK to apply the settings.

For detailed instructions on adding the .ini and . MIME Types, refer to Wyse Knowledge 
Base Solution #21581 (go to the Wyse Knowledge Base at http://www.wyse.com/kb and 
search for 21581).
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Step 2: Direct the Thin Client to the Server
After you set up the folder structure and populate it with the correct files, you must then 
direct the thin client to the location of the server by one of the following ways:
• DHCP (see "Using DHCP")
• Manual direction (see "Manually Configuring the Server Location")

IMPORTANT: Using DHCP is strongly recommended.

Using DHCP
When using DHCP to direct the thin client to the location of the server (recommended), 
information about the server and root directory is obtained from the following DHCP 
options: 
• 161 - The server.
• 162 - Root path to the server (ftp/http/https).

· If no root path is defined, /wyse is assumed.
· If a root path is defined, the additional path will be appended to the URL supplied by 

option 161.
• 184 - (Optional) Server username (to server specified in option 161).
• 185 - (Optional) Server password (to server specified in option 161).

TIP: Check-in for configuration changes is done early in the boot process. For that reason, 
changes in DHCP information may not be propagated to a unit until a full boot is 
completed. However, you can avoid this by forcing a renewing of the DHCP lease, which 
makes sure that the unit has the latest file-server location before the next check. Simply, 
right-click the Network Manager icon, click Enable Networking to disable it, right-click 
the Wireless Manager icon, and then click Enable Networking to enable it again (the 
DHCP lease is renewed).

TIP: For general instructions on adding DHCP Options #161 and #162, refer to Wyse 
Knowledge Base Solution #16132 (go to the Wyse Knowledge Base at 
http://www.wyse.com/kb and search for 16132).

Use the guidelines shown in Table 3 when creating and adding the DHCP options you 
need. 

Table 3 DHCP Option Tags 

Option Description Notes

1 Client identifier Always sent.

2 Time Offset Optional.

3 Router Optional but recommended. It is not required 
unless the thin client must interact with servers 
on a different subnet.

6 Domain Name Server
(DNS)

Optional but recommended. 

12 Host Name/Terminal 
Name

Optional string. The host name or terminal name 
to be set.

15 Domain Name Optional but recommended. See Option 6.

28 Broadcast Address Optional. 
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44 WINS servers IP 
Address 

Optional. 

51 Lease Time Optional but recommended. 

52 Option Overload Optional. 

53 DHCP Message Type Recommended. 

54 DHCP Server IP 
Address

Recommended. 

55 Parameter Request 
List

Sent by appliance.

57 Maximum DHCP 
Message Size

Optional (always sent by thin client).

58 T1 (renew) Time Optional but recommended.

59 T2 (rebind) Time Optional but recommended.

61 Client identifier Always sent.

161 Server (ftp/http/https) Optional string. If this is an IP address or 
resolvable hostname, the protocol is assumed to 
be FTP; however, it may be the leading portion of 
a URL that specifies another protocol. If using the 
URL form, it should not include a trailing slash 
(for example, http://server.example.com or ftp://
192.168.0.1).

162 Root path to the server 
(ftp/http/https)

Optional string. The relative directory starting 
from the root directory must be given. For 
example, on an FTP server, the full directory may 
be C:/Inetpub/ftproot/wyse, where wyse 
is the directory that contains the INI files. In this 
example, the correct string value for this DHCP 
option is /wyse. 
On a Linux server, an FTP user-based directory 
might be /home/test/wyse. In this example, if 
the FTP user is test, then the FTP root path is  
/wyse and not the full path (/home/test/wyse).
This value should use URL path notation (start 
with a forward slash, /, and use a forward slash 
as folder separators).

181 Wyse PN Server Optional string. IP address or FQDN of the 
PNLite server.

182 Wyse Admin List Optional string. DHCP equivalent of the 
DomainList ini file parameter.

184  Server Username Optional string. Username to use when 
authenticating to the server specified in Option 
161.

Table 3 DHCP Option Tags, Continued

Option Description Notes
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Manually Configuring the Server Location
To manually configure the server location (not recommended), open the INI Settings 
dialog box (click System Settings icon and then click INI Settings), and enter the URL 
(for HTTP or HTTPS; FTP URL is allowed for FTP) for the INI server in the INI Server 
URL text box. For more information, see "INI (Source) Settings." 

Step 3: Reboot the Thin Client
After you reboot (or start the thin client), the thin client will look in the defined root path for 
the latest available configuration changes if necessary. Additionally, it will check the 
directory file in the addons folder to see if any changes for installed add-ons are defined. 
Add-ons that exist in the addons folder but are not listed in the directory file, will be ignored 
during check-in.

185  Server Password Optional string. Password to use when 
authenticating to the server specified in Option 
161.

186 Wyse Device Manager 
(WDM) 

Optional binary IP address or FQDN of the WDM 
server. This option can specify up to one Wyse 
Device Manager server. 

Table 3 DHCP Option Tags, Continued

Option Description Notes
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